
 

 
 
 
 
 

กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลย ี
ง30247  การออกแบบเว็บไซต                                ชั้นมัธยมศึกษาปท่ี 6            
ภาคเรียนท่ี 2  เวลา 40 คาบ                       จํานวน  1.0  หนวยกิต 
                                                

ผูเรียนจะไดรับการพัฒนาใหมีความรู ความเขาใจ ศึกษา วิเคราะห ฝกปฏิบัติ เพื่อใหมีความรูความ
เขาใจ  ตระหนักและเห็นคุณคาในเรื่องตอไปน้ี  หลักการเบื้องตนเกี่ยวกับการสรางเว็บเพจ  ความรูเกี่ยวกับ
อินเตอรเน็ตเบื้องตน, กระบวนการพัฒนาเว็บเพจ, หลักการออกแบบเว็บเพจ, โปรแกรมที่ใชในการสราง    
เว็บเพจ,  เริ่มตนสรางเว็บเพจ, การใชขอความในเว็บเพจ,  การใชภาพกราฟกในเว็บเพจ,  การใชตารางใน  
เว็บเพจ, การเช่ือมโยงเว็บเพจ, การจัดแบงเว็บเพจดวยเฟรมเซต, การสรางเลเยอร,  การใชมัลติมีเดีย      
บนเว็บเพจ, และการอัพโหลดเว็บไซตเขาสูอินเตอรเน็ต  

ใชทักษะกระบวนการเรียนรู  กระบวนการคิด  กระบวนการแกปญหา กระบวนการกลุม  
กระบวนการปฏิบัติ  เพื่อใหเกิดความตระหนักและเห็นคุณคา มีความรู  ความเขาใจ  และมีทักษะในการ
ปฏิบัติงาน   สามารถสรางเว็บเพจเผยแพรขอมูลสูอินเตอรเน็ต หรือสรางสรรคโครงงานการประยุกตใชงาน 
เว็บเพจกับแหลงเรียนรูทองถ่ินไดอยางเหมาะสม    

สามารถและมีคุณลักษณะ มีความรับผิดชอบ และมีคุณธรรมจริยธรรมในการใชงานเทคโนโลยี  การ
วัดและประเมินผลใชวิธีที่หลากหลาย และประเมินตามสภาพจริง  

 
ผลการเรียนรู 
1. มีความรูความเขาใจพื้นฐานของการออกแบบเว็บไซต 
2. บอกหลักการและสามารถออกแบบเว็บไซตได 
3. อธิบายโครงสรางและคําสั่งพื้นฐาน และออกแบบเว็บไซตดวยภาษา HTML เบื้องตนได 
4. มีความรูความเขาใจพื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 
5. มีความรูและทักษะในการสรางตารางบนเว็บเพจ 
6. มีความรูและทักษะในการเช่ือมโยงเว็บเพจ (Link) 
7. มีความรูและทักษะในการจัดแบงหนาเว็บดวยเฟรม (Frame) และการจัดวางเน้ือหาดวย Layer 
8. มีความรูและทักษะในการสรางหัวเว็บไซตและปุมกดดวยโปรแกรม Adobe Photoshop CS3 
9. มีความรูและทักษะในการใสสื่อแบบ Multimedia และสรางภาพเคลื่อนไหวดวยโปรแกรม 

Adobe Flash CS3 
10. มีความรูและทักษะในการอัพโหลดเว็บไซตข้ึนสูอินเตอรเน็ตได 
11. มีความรูและทักษะในการสรางสรรคโครงงานการประยุกตใชงานเว็บเพจกับแหลงเรียนรูทองถ่ิน 

 
รวมท้ังหมด  11  ผลการเรียนรู 
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 คําอธิบายรายวิชาเพ่ิมเติม 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

 
ในการเรียนรูบทเรียนบนเครือขายอินเตอรเน็ต เรื่อง การออกแบบเว็บไซตดวยโปรแกรม 

Macromedia Draemweaver 8 กลุมสาระการเรียนรูการงานอาชีพและเทคโนโลยี (สาระเพิ่มเติม) 
ช้ันมัธยมศึกษาปที่ 6 หนวยการเรียนรูที่ 3 ประกอบดวย 7 บทเรียน ดังน้ี 
 ชุดที่ 1 เรื่อง พื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 
 ชุดที่ 2 เรื่อง การสรางตารางบนเว็บเพจ 
 ชุดที่ 3 เรื่อง การเช่ือมโยงเว็บเพจ (Link) 
 ชุดที่ 4 เรื่อง การจัดแบงหนาเว็บดวยเฟรม (Frame) และการจัดวางเน้ือหาดวย Layer 
 ชุดที่ 5 เรื่อง การสรางหัวเว็บไซตและปุมกดดวยโปรแกรม Adobe Photoshop CS3 
 ชุดที่ 6 เรื่อง การใสสื่อแบบ Multimedia และสรางภาพเคลื่อนไหวดวย 

         โปรแกรม Adobe Flash CS3 
ชุดที่ 7 เรื่อง การเผยแพรเว็บไซต (Website Publishing) 
โดยการนําเสนอเน้ือหาเปนขอความ ภาพน่ิง วีดิทัศน นักเรียนสามารถควบคุมและเรียนรูบทเรียนได

ดวยตนเองตลอดการใชงาน ซึ่งทําใหนักเรียนมีสวนรวมในการเรียนและสามารถศึกษาทําความเขาใจบทเรียน
ไดดีย่ิงข้ึน นักเรียนสามารถศึกษาข้ันตอนการใชบทเรียนบนเครือขายอินเตอรเน็ต ไดจากคูมือการใชบทเรียน
บนเครือขายอินเตอรเน็ต มีลําดับข้ันตอนดังน้ี 

1. เขาสูระบบบทเรียนบนเครือขายอินเตอรเน็ต ผานเว็บไซต www.krutheerachai.com โดย 
ระบุช่ือผูใชและรหัสผานที่ครูแจงใหทราบเปนรายบุคคล 

2. ศึกษาจุดประสงคการเรียนรู 
3. ทําแบบทดสอบกอนเรียน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ 
4. ศึกษาใบความรูหรือวีดิทัศน 
5. ทําใบงาน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ หากทําใบงานไมผานเกณฑการ 

ประเมินรอยละ 80 ใหกลับไปศึกษาใบความรูและวีดิทัศนอีกครั้ง 
6. ทําแบบฝกปฏิบัติ เมื่อสงไฟลช้ินงานผานบทเรียนบนเครือขายอินเตอรเน็ต ครูผูสอนเปนผูตรวจ 

ในภายหลัง และแจงผลการประเมินใหนักเรียนทราบผานบทเรียนบนเครือขายอินเตอรเน็ต เกณฑการ
ประเมินคุณภาพระดับดีข้ึนไปหรือเทียบระดับคะแนนไดไมตํ่ากวารอยละ 80  

7. ทําแบบฝกหัด เมื่อสงคะแนนระบบจะเฉลยและแจงคะแนนใหทราบ หากทําแบบฝกหัดไมผาน 
เกณฑการประเมินรอยละ 80 ใหกลับไปศึกษาใบความรูและวีดิทัศนอีกครั้ง 

8. ทําแบบทดสอบหลังเรียน เมื่อสงคําตอบระบบจะเฉลยและแจงคะแนนใหทราบ หากทํา 
แบบทดสอบหลังเรียนไมผานเกณฑรอยละ 80 ใหกลับไปทบทวนใบความรูและวีดิทัศนอกีครั้ง 

9. ทําการออกจากระบบ 
10. หากมีปญหาหรือขอสงสัยใดๆ ใหสอบถามครูผูสอนทันท ี
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คําแนะนําการใชบทเรียนบนเครือขายอินเตอรเน็ต 

จัดทําโดย : นายธีรชัย  สายรัตน 
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แผนผังเว็บไซตบทเรียนบนเครือขายอินเตอรเน็ต 

หนาแรก/เขาสูระบบ 
ตามรหัสผานที่ครูแจง 

คําแนะนําการใชบทเรียน 
บนเครือขายอินเตอรเน็ต 

จุดประสงค แบบทดสอบกอนเรียน 

ศึกษาใบความรู 
ศึกษาวีดิทัศน 

ใบงาน ผานเกณฑ ไมผานเกณฑ 

แบบฝกปฏิบัติ แบบฝกหัด ไมผานเกณฑ 

ผานเกณฑ 

แบบทดสอบหลังเรียน ไมผานเกณฑ 

ผานเกณฑ แบบทดสอบวัดผลสัมฤทธ์ิ 
ทางการเรียน(หลังเรียน) 

ออกจากระบบ 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

 
1. เขาเว็บไซต www.krutheerachai.com โดยใชเว็บบราวเซอร Google Chrome 
2. กรอกช่ือผูใชและรหัสผาน ใหนักเรียนใชเลขประจําตัวนักเรียน 5 หลักและรหัสผานที่ครูแจง 

ตัวอยางที่ใช ช่ือผูใช 00001 รหัสผาน Std-00001 

3. คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

 
ภาพประกอบที่ 1.1 การเขาสูบทเรียน 

 
4. เมื่อเขาสูระบบสําเร็จจะปรากฏช่ือผูใชบนหนาจอ 
5. คลิกเลือกวิชาเรียนการออกแบบเว็บไซต 
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 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

การเขาสูบทเรียน 

 

 1 

 2 

 3 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 

 
ภาพประกอบที่ 1.2 การเลือกวิชาเรียน 

 6. เลือกบทเรียนที่ตองการศึกษา ในที่น้ีเลือกชุดที่ 1 พื้นฐานการสรางเว็บเพจดวยโปรแกรม 
Macromedia Dreamweaver 8 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.3 เลือกบทเรียนชุดที่ 1 
 
 
 
 1. คลิกเลือกจุดประสงคการเรียนรูที่ 1 

 2. ระบบจะแจงขอมูลการดาวนโหลดไฟลจุดประสงคการเรียนรูที่ 1 ใหคลิกที่ปุมเรียกดู  
3. ใหโหลดเก็บไวในไดรฟ D: คลิก New folder เพื่อสรางโฟลเดอรช่ือบทเรียนชุดที่ 1 แลวกดEnter 
4. ดับเบิ้ลคลิกเขาไปในโฟลเดอรบทเรียนชุดที่ 1 คลิกปุม  

 5. คลิกปุมเริ่มดาวนโหลด  
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 4 

 5 

 

จุดประสงคการเรียนรูท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 

 6 



 

 
 6. โหลดเสร็จแลวคลิกที่ปุมเปด  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.4 ข้ันตอนการดาวนโหลดไฟลจุดประสงคการเรียนรูที่ 1 
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 2 

 

 3 

 

 5 

 6 

จัดทําโดย : นายธีรชัย  สายรัตน 
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การสรางเว็บไซตเราสามารถสรางไดจากโปรแกรมที่หลากหลาย โปรแกรม Macromedia 
Dreamweaver 8 เปนโปรแกรมหน่ึงที่มีความสามารถในการสรางเว็บไซต การเรียนรูสวนประกอบและ
อธิบายถึงหนาที่การใชงานสวนประกอบตางๆของโปรแกรม Macromedia Dreamweaver 8 ออกแบบ
และเริ่มตนสรางเว็บไซต ใสขอความและจัดรูปแบบของขอความในเว็บเพจ ตกแตงเว็บเพจดวยรูปภาพ
และกําหนดคุณสมบัติของรูปภาพ และบันทึกหนาเว็บเพจ มีความจําเปนและสําคัญตอการพัฒนาเว็บไซต 
 

 

 
สาระสําคัญ 

 

มีความรูความเขาใจ และมีทักษะเบื้องตนการใชงานโปรแกรม Macromedia 
Dreamweaver 8 

 
ดานความรู (K) 

1. บอกสวนประกอบและอธิบายถึงหนาที่การใชงานสวนประกอบตางๆของ
โปรแกรม Macromedia Dreamweaver 8 ได 

ดานทักษะ/กระบวนการ (P) 
1. ออกแบบและเริ่มตนสรางเว็บไซตไดอยางถูกตอง 
2. ใสขอความและจัดรูปแบบของขอความในเว็บเพจไดอยางถูกตอง 
3. ตกแตงเว็บเพจดวยรูปภาพและกําหนดคุณสมบัติของรูปภาพไดอยางถูกตอง 
4. บันทึกหนาเว็บเพจไดอยางถูกตอง 

ดานคุณลักษณะ (A) 
1. ต้ังใจทํางาน มีนํ้าใจเอื้อเฟอเสียสละ มีระเบียบวินัย มีความซื่อสัตย 
2. รับผิดชอบงานที่ไดรับมอบหมาย 

 

 

 
ผลการเรียนรู 

จุดประสงคการเรียนรู 

 

1.  หนาที่การใชงานสวนประกอบตางๆของโปรแกรม Macromedia Dreamweaver 8 
2.  ออกแบบและเริ่มตนสรางเว็บไซต 
3.  ใสขอความและจัดรูปแบบของขอความในเว็บเพจ ตกแตงเว็บเพจดวยรูปภาพและ 
     กําหนดคุณสมบัติของรูปภาพ 
4.  บันทึกหนาเว็บเพจ 

 

 
สาระการเรียนรู 

จัดทําโดย : นายธีรชัย  สายรัตน 
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1. คลิกเลือกแบบทดสอบกอนเรียนที่ 1 
 
 
 
 
 

 
ภาพประกอบที่ 1.5 การเลือกแบบทดสอบกอนเรียนที่ 1 

 
2. ทําแบบทดสอบกอนเรียนที่ 1 โดยอานคําช้ีแจงใหเขาใจ 

คําช้ีแจง แบบทดสอบกอนเรียนที่ 1 เปนแบบทดสอบแบบปรนัย 4 ตัวเลือก จํานวน 10 ขอ  
ใหคลิกเลือกคําตอบที่ถูกที่สุดเพียงคําตอบเดียว คะแนนเต็ม 10 คะแนน แบบทดสอบน้ีจับเวลาในการทํา
แบบทดสอบ 10 นาท ี

3. คลิกปุม  
 
 
 
 
 

 
 
 

ภาพประกอบที่ 1.6 คําช้ีแจงแบบทดสอบกอนเรียนที่ 1 
 

4. จะปรากฏหนาจอการยืนยันจากระบบ “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 

4.1 ถายังไมตองการทําแบบทดสอบกอนเรียนที่ 1 ใหคลิกปุม  

4.2 ถาตองการทําแบบทดสอบกอนเรียนที่ 1 ใหคลิกปุม  
 

 
 
 
 

ภาพประกอบที่ 1.7 การยืนยันการทําแบบทดสอบกอนเรียนที่ 1 
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แบบทดสอบกอนเรียนท่ี 1  

 

 1 

 

 2 

 3 

 

  4.2 4.1 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 5. แบบทดสอบกอนเรียนจํานวน 10 ขอ โดยนําเมาสไปคลิกที่วงกลมหนาตัวเลือก a, b, c, หรือ d 
ที่ตองการตอบ โดยขอสอบจะมีการสลับขอและสลับตัวเลือกทุกครั้งเมื่อมีการทําแบบทดสอบ 

 6. เมื่อทําแบบทดสอบกอนเรียนที่ 1 เสร็จเรียบรอย คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.8 แบบทดสอบกอนเรียนที่ 1 
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จัดทําโดย : นายธีรชัย  สายรัตน 

 5 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.9 แบบทดสอบกอนเรียนที่ 1 (ตอ) 
 

 7. ระบบจะแจงสถานะของการทํางานแบบทดสอบกอนเรียนที่ 1 ใหปฏิบัติดังน้ี 
     7.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Not yet answered” แสดงวาทํา 

แบบทดสอบกอนเรียนที่ 1 ไมครบ ใหคลิกปุม  
     7.2 ถาสถานะคําตอบทุกขอแสดงคําวา “Answer saved” แสดงวาทําแบบทดสอบกอนเรียน   

ที่ 1 ครบทุกขอ ใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  ภาพประกอบที่ 1.10  ระบบแจงสถานะการทําแบบทดสอบกอนเรียนที่ 1 
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 6 

 

 

 

7.1 

7.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 8. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 

     8.1 ถาตองการกลับไปแกไขคําตอบใหคลิกปุม  

     8.2 ถาตองการสงคําตอบใหคลิกปุม  
 
 
 
 
 
 
 
  ภาพประกอบที่ 1.11  ระบบแจงการยืนยันการสงแบบทดสอบกอนเรียนที่ 1 
 

 9. เมื่อคลิก  ระบบจะเฉลยแบบทดสอบกอนเรียนที่ 1 วาถูกหรือ
ผิด ใหเลื่อนดูจนครบทั้ง 10 ขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่ “Finish review” 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.12  ระบบเฉลยแบบทดสอบกอนเรียนที่ 1 
  

10. ระบบจะแจงคะแนนที่ได จากน้ันใหคลิกปุม  เพื่อกลับสูบทเรียนถัดไป 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.13  ระบบแสดงคะแนนแบบทดสอบกอนเรียนที่ 1 
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จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

1. คลิกใบความรูที่ 1 เพื่อเขาศึกษาเน้ือหาบทเรียน 
2. ระบบจะแจงขอมูลการดาวนโหลดไฟลใบความรูที่ 1 ใหดาวนโหลดเก็บไวในไดรฟ D: โฟลเดอร 

ช่ือ บทเรียนชุดที่ 1 คลิกปุม   

3. เมื่อดาวนโหลดเสร็จแลวคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.14  ข้ันตอนการดาวนโหลดไฟลใบความรูที่ 1 
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 เน้ือหาบทเรียน 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 
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Macromedia Dreamweaver 8 เปนโปรแกรมสําหรับพัฒนาเว็บไซต ซึ่งมีคุณสมบัติ 

ครอบคลุมต้ังแตการออกแบบและสรางเว็บเพจ การบริหารจัดการเว็บไซต ตลอดไปจนถึงการพัฒนาเว็บ
แอพพลิเคช่ัน โปรแกรมน้ีไดรับความนิยมเปนอยางสูงในบรรดาโปรแกรมประเภทเดียวกันเน่ืองจากคุณสมบัติ
เดนคือใชงานงาย มีเครื่องมืออํานวยความสะดวกในการจัดวางขอความ ภาพกราฟก ตาราง แบบฟอรม 
มัลติมีเดีย รวมทั้งองคประกอบตางๆ ที่ใชโตตอบกับผูชมลงในเว็บเพจไดอยางงายดาย โดยผูใชไมจําเปนตอง
รูจักภาษา HTML, CSS, JavaScript และภาษาสคริปตอื่นๆ ดังน้ันจึงเหมาะสําหรับผูเริ่มตนและผูใชทั่วไป 
นอกจากน้ียังมีคุณสมบัติช้ันสูงอีกมากมายสําหรับนักพัฒนาเว็บไซตมืออาชีพดวยเชนกัน 
 

 
ถึงแม Macromedia Dreamweaver 8 เปนโปรแกรมที่ไมตองใชเครื่องมือที่มีประสิทธิภาพ 

สูงมากนัก แตในการใชงานโดยปกติ เราอาจจําเปนตองใชโปรแกรมอื่นๆ รวมในการทํางานดวย เชน 
โปรแกรมตกแตงภาพ โปรแกรมสรางภาพเคลื่อนไหว (Animation) เปนตน ดังน้ันความตองการของเครื่อง
คอมพิวเตอรข้ันตํ่าที่นํามาสรางเว็บเพจ ควรเปนดังน้ี 
   สําหรับเครื่อง PC    สําหรับเครื่อง Macintosh 
หนวยประมวลผลกลาง Intel Pentium หรือ AMD Athlon 64 Multicore Intel Processor 
(CPU) 
ระบบปฏิบัติการ  Windows XP SP2 (แนะนํา SP3) หรือ Mac OS X 
   Windows Vista Home Premium, v. 10.5.8 หรือ v.10.6 
   Bussiness, Ultimate หรือ Enterprise 
   SP1 หรือ Windows 7 
หนวยความจํา (RAM) 512 MB (แนะนํา 1 GB)   512 MB (แนะนํา 1 GB) 
เน้ือที่ฮารดดิสก  อยางนอย 1 GB    อยางนอย 1.8 GB 
 
ตัวอยางโปรแกรมท่ีใชในการสรางเว็บไซต ดังน้ี 
 Microsoft Expression, Web Designner, Amaya, Macromedia Dreamweaver 8, Editplus, 
Microsoft FrontPage, Mini Fast Web Editor, KompoZor, WordPress เปนตน 
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จัดทําโดย : นายธีรชัย  สายรัตน 

รูจักกับ Macromedia Dreamweaver 8 

ความตองการเครื่องคอมพิวเตอรท่ีเหมาะสมกับ Macromedia Dreamweaver 8 

 

ใบความรูที ่1 
เรื่องพื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 



 

 

 
เปดโปรแกรม Macromedia Dreamweaver 8  จะเห็นหนาจอที่เขาใจงายตอการออกแบบและ

ปรับเปลี่ยนไดตามความถนัดของผูใช การออกแบบจะอยูในสวนที่เรียกวาหนา DOCUMENT ซึ่งเปนการงาย
ตอการออกแบบ ข้ันตอนการเขาสูโปรแกรม Macromedia Dreamweaver 8   สําหรับ Windows 7 ทําได
ดังน้ี 

1. คลิกที่ปุม Start 
2. คลิกเลือกคําสั่ง All Programs 
3. คลิกเลือก Macromedia (ภาพประกอบที่ 1.1) 

 

  

ภาพประกอบที่ 1.15 แสดงการเขาสูโปรแกรม Macromedia Dreamweaver 8 
 
4. คลิกเลือกคําสั่ง Macromedia Dreamweaver 8  เพื่อเรียกใชงานโปรแกรม  

(ภาพประกอบที่ 1.2) 

( 
ภาพประกอบที่ 1.16 แสดงการเขาสูโปรแกรม Macromedia Dreamweaver 8 (ตอ) 
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 การเปดใชงานโปรแกรม Macromedia Dreamweaver 8 
 

 

 
   1 

 

 
 2  

 
 3 

 

 
 4 

จัดทําโดย : นายธีรชัย  สายรัตน 
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5. เมื่อคลิกเลือกคําสั่ง Macromedia Dreamweaver 8  โปรแกรมจะเขาสูหนาจอ  
Start Page (ภาพประกอบที่ 1.3) 
 

 

 

 

 
ภาพประกอบที่ 1.17 แสดงหนาจอ Start Page โปรแกรม Macromedia Dreamweaver 8 

 
หนาจอ Start Page มีสวนประกอบที่สําคัญ 3 สวน ดังภาพประกอบที่ 1.3 คือ 

- สวนที่ 1 Open a Recent Item เปดเว็บเพจที่เคยใชงานมาแลว โดยเลือกจากรายช่ือที่ 
แสดงอยู 

- สวนที่ 2 Create New สรางเว็บเพจใหม โดยเลือกประเภทของไฟลชนิดตางๆ ได 
- สวนที่ 3 Create from Samples สรางเว็บเพจใหมจากไฟลตัวอยางที่โปรแกรมได 

เตรียมรูปแบบไวแลว 
ในบทเรียนน้ีเราจะคลิกเลือกที่ HTML ในสวนของ Create New เพื่อสรางเว็บเพจเปลาแบบพื้นฐานข้ึนมา
ใหม จากน้ันจะเขาสูหนาจอเริ่มตนของโปรแกรม Macromedia Dreamweaver 8   
 

 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 
สวนท่ี  1 

 

 

สวนที ่ 2 
 

 

สวนท่ี  3 

 

 

คลิกถาไมตองการแสดง 
Start Page ในการเปด
โปรแกรมคร้ังตอไป 

 

 

ศึกษาบทเรียนชวยสอน 
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ภาพประกอบที่ 1.18 แสดงสวนประกอบของหนาจอ โปรแกรม Macromedia Dreamweaver 8 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 สวนประกอบของโปรแกรม Macromedia Dreamweaver 8 

 

 
แถบช่ือโปรแกรม 

 

 
แถบเมนูคําสั่ง คือสวนที่เก็บคําสั่งสําหรับการทํางานตางๆ 

 

แถบ Insert Bar คือทูลบารที่ประกอบไปดวยปุมคําสั่ง 
ที่ใชแทรกออบเจ็คชนิดตางๆ ลงไปในเว็บเพจ 
 

 

 

 

 

แท็บช่ือไฟลเว็บเพจ 

 
 

 

ทูลบาร Document คือแถบเครื่องมือที่รวบรวม 
คําสั่งตางๆ ที่เราจําเปนตองใชงานบอย  ๆ
 

 

 

ปุมยุบ/ยอ/ปดวินโดว Document 

วินโดว Document คือสวนที่ใชสําหรับใสเน้ือหา 
และจัดองคประกอบของเว็บเพจลงไป 
 

 

 

แถบสถานะ Status Bar 
เปนแถบแสดงสถานะของเว็บเพจ  
 

 

 

พาเนล Properties Inspector เปนพาเนลที่เราใชงานมากที่สุด 
โดยจะแสดงคุณสมบัติของออบเจ็คที่กําลังเลือกบนเว็บเพจ 
 

 

 

กลุมพาเนลตางๆ  เปนกรอบเล็กๆ ที่ 
ประกอบดวยเครื่องมือสําหรับใชทํางานตาง  ๆ
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ในการสรางเว็บเพจ เราสามารถเลือกมุมมองในการทํางานได 3 มุมมองคือ Design, Code  

และ Code and Design ซึ่งจะชวยใหการสรางเว็บเพจสะดวกรวดเร็วมากย่ิงข้ึน 
 

 
ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 

ในลักษณะคลายกับที่เราเห็นในบราวเซอรไมวาจะเปน 
ขอความ ภาพกราฟก หรือออบเจ็คอื่นๆ โดยที่เราสามารถ 
แกไขและจัดวางเน้ือหาตางๆลงในเว็บเพจไดตามตองการ  
ซึ่งสวนใหญเราจะทํางานในมุมมองน้ี 
 
 

 
 
 
 
 

    ภาพประกอบที่ 1.19 แสดงมุมมอง Design 

ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 
ในรูปของชุดคําสั่งภาษา HTML ที่ถูกสรางข้ึนโดยโปรแกรม 
Dreamweaver หรือเปนคําสั่งที่เราเขียนเพิ่มเขาไปเอง 
นอกจากน้ีก็อาจจะมีคําสั่งสไตลชีต (CSS) และภาษา 
สคริปต (script) ตางๆ ดวยเราสามารถตรวจสอบและ 
แกไขคําสั่งเหลาน้ีไดตามตองการ ซึ่งการแกไขจะสงผล 
กลับไปยังมุมมองออกแบบโดยอัตโนมัติ 
 
 
 
  
 
         ภาพประกอบที่ 1.20 แสดงมุมมอง Code 
 
 

 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

มุมมองการทํางานใน Macromedia Dreamweaver 8 
 

มุมมองออกแบบ (Design View) 

 

 

 
คลิกที่ปุม Design จะปรากฏมุมมองออกแบบ 

มุมมองโคด (Code View) 

 

 

 
คลิกที่ปุม Code จะปรากฏมุมมองโคด 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 ในมุมมองน้ีวินโดว Document จะแสดงเว็บเพจ 
ทั้งในรูปแบบที่ปรากฏบนบราวเซอร และรูปแบบคําสั่ง 
ภาษา HTML พรอมๆ กัน โดยจะแสดงสวนที่เปนคําสั่งไว 
ดานบนและแสดงเว็บเพจปกติไวดานลาง เพื่อใชในการ 
ออกแบบและตรวจสอบแกไขคําสั่งไปในขณะเดียวกัน 
เราสามารถปรับขนาดพื้นที่ของแตละสวนไดโดยการคลิก 
ลากที่เสนแบงระหวางทั้ง 2 สวน 
 

 

 

        
                   ภาพประกอบที่ 1.21 แสดงมุมมอง Code and Design 

 
 เน่ืองจากเว็บไซตประกอบไปดวยเว็บเพจและไฟลที่เกี่ยวของจํานวนมาก โดยเฉพาะเว็บไซตขนาด

ใหญอาจมีจํานวนนับพันไฟล ดังน้ันเราจึงควรวางแผนลวงหนาวาจะจัดเก็บไฟลเหลาน้ีอยางไร 

     
 

 

 

 
 
 ในตัวอยางขางตนไดสรางโฟลเดอรหลักช่ือ school และสรางโฟลเดอรยอย คือ images , sound , 
button , multimedia และไดสรางไฟลเว็บเพจในโฟลเดอรหลักช่ือ index.html 
 

 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 
 ไฟลหนาแรกของเว็บไซตตองตั้งช่ือวา index.html หรือ index.php เทานั้น NOTE : 

มุมมองโคดและออกแบบ (Code and Design View) 

 

 

 

คลิกที่ปุม Split จะปรากฏมุมมองโคด 
และออกแบบ 
 

การกําหนดโครงสรางของไฟลและโฟลเดอรในเว็บไซต 

 

   
  

 

  
 

 
 

images 

sound 

button 

multimedia 

index.html 
 

 

โฟลเดอรยอย 
 

  โฮมเพจ 

จัดทําโดย : นายธีรชัย  สายรัตน 
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สิ่งที่เราควรทําเปนอยางแรกในการสรางเว็บไซตดวย Dreamweaver ก็คือการสราง 

Dreamweaver Site เพื่อที่จะกําหนดช่ือเว็บไซตและระบุโฟลเดอรสําหรับจัดเก็บไฟล โฟลเดอรน้ีจะเปน
แหลงรวมเว็บเพจ ภาพกราฟก และไฟลอื่นๆ ที่เกี่ยวของใหอยูในที่เดียวกัน เพื่อความสะดวกเวลาเราจะอัพ
โหลดเว็บไซตข้ึนสูอินเตอรเน็ต รวมทั้งการบริหารจัดการอื่นๆ โฟลเดอรน้ีอาจอยูที่ใดก็ไดภายในโครงสราง
ไฟลของ  Windows ในเครื่องของเรา โดยจะถือเปนจุดเริ่มตนหรือโฟลเดอรหลัก(root folder) ของ
เว็บไซต จากจุดน้ีเราสามารถสรางโฟลเดอรยอยสําหรับแยกเก็บไฟลตามประเภทหรือตามเน้ือหา (ดังกลาว
แลวในหัวขอกอน) โดยการสรางโฟลเดอรยอยน้ีคุณจะทําในระบบ Windows หรือใน Dreamweaver ก็ได
เชนกัน 

 

 
1. เลือกคําสั่ง Site > New Site จากแถบเมนู 
2. ในไดอะล็อกบอกซ Site Definition for Unnamed Site1 ใหคลิกที่แท็บ Basic 
3. ในหัวขอ Editing Files หนาแรก ใหพิมพช่ือเว็บไซตลงไปที่ชอง What would you  

Like to name your site? แลวคลิกปุม  
4. ในหัวขอ Editing Files, Part2 ใหกําหนด server technology โดยในข้ันตอนน้ีให 

เลือก No, I do not  want to use server technology แลวคลิกปุม               (ยังไมกําหนดเซิรฟเวอร
เทคโนโลยี) 
 

 

 

 

 

 

 

 

 

 
 
ภาพประกอบที่ 1.22 แสดงข้ันตอนการสรางเว็บไซตใหมดวยวิซารด 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

สราง Dreamweaver Site 

สรางเว็บไซตใหมดวยวิซารด 

 

 

 

 

 

 

 
   1 

 

 
   2 

 

 
   3 

 

 

 

 
   4 
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5. ในหัวขอ Editing Files, Part 3 ใหระบุโฟลเดอรหลักที่ใชเก็บขอมูลทั้งหมดของเว็บไซต  
โดยคลิกที่ไอคอน  เพื่อเปดเขาไปในโฟลเดอรที่ตองการ 

5.1 แลวคลิกปุม  (หรือใชวิธีพิมพพาธของโฟลเดอรลงไปเองก็ได)  
5.2 จากน้ันคลิกปุม  (ภาพประกอบที่ 1.9) 

6. หลังจากน้ันจะปรากฏหนาจอของหัวขอ Sharing Files ใหเลือกเปน None (ยังไม 
กําหนด Remote Info) แลวคลิกปุม  

7. จะปรากฏหนาจอ Summary ซึ่งแสดงรายละเอียดของเว็บไซต ใหคลิกปุม  
เพื่อจบการสราง 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 

 

เว็บไซตที่สรางใหมจะถูกเปดใชโดยอัตโนมัติ 
   ภาพประกอบที่ 1.23 แสดงข้ันตอนการสรางเว็บไซตใหมดวยวิซารด 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

 

 

 

   5 
 

 

   5.1 

 

 

   5.2 

 

 

 

 

 
   6 

  

 

 

 

   7 
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เว็บไซตที่สรางใหมจะถูกเปดข้ึนใชงานทันที โดยช่ือจะไปปรากฏที่พาเนล Files (ถาบนหนาจอยังไม
แสดงพาเนล Files ใหเลือกคําสั่ง Windows > File) 

 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่  1.24 แสดงข้ันตอนการสรางโฟลเดอรใหม 

 
หลังจากที่คุณสรางเว็บไซตไปแลว ถาตองการเปลี่ยนช่ือหรือรายละเอียดอื่นๆ ของเว็บไซตก็สามารถ

ทําไดดังน้ี 
1. เลือกคําสั่ง Site > Manage Sites จากเมนู  

 
ภาพประกอบที่ 1.25 แสดงข้ันตอนการแกไขเว็บไซต 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 แกไขเว็บไซต 
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- ในขอ 3 ช่ือเว็บไซตที่ต้ังน้ี เปนชื่อเพื่อใชอางอิงภายในเครื่องของ 
คุณเองเทาน้ัน จึงไมจําเปนตองต้ังตามชื่อโดเมนเนม และไมจําเปนตองเหมือนกับชื่อ
เว็บไซตทิ่จะใชบนอินเตอรเน็ตเซิรฟเวอร (หลังจากที่อัพโหลดเว็บไซตแลว) แตอยางใด 

- ในขอ 5 ถาคุณไมระบุอะไร โปรแกรมจะสรางโฟลเดอรชื่อ 
เดียวกับชื่อเว็บไซตข้ึนมาใหโดยอัตโนมัติ 

- คุณสามารถสรางเว็บไซตโดยเลือกจากโฟลเดอรท่ีมีอยูแลว ซ่ึงถา 
หากในโฟลเดอรดังกลาวมีไฟลตางๆ อยูกอน ไฟลเหลาน้ันก็จะถูกรวมเขามาในเว็บไซตที่
สรางใหมดวย 

- ถาหากคุณไมไดสรางโฟลเดอรเตรียมไวลวงหนา ก็สามารถสราง 
โฟลเดอรใหมสําหรับเว็บไซตไดในข้ันตอนที่ 5 โดยคลิกปุม  ดังรูป แลวต้ังชื่อ
โฟลเดอร จากน้ันดับเบิ้ลคลิกเพื่อเปดเขาไปในโฟลเดอรน้ี แลวคลิกปุม   
 

       คลิกสรางโฟลเดอรใหม 
 

 

 

 

 
 
 

NOTE : 

 

 

 

ต้ังช่ือโฟลเดอร 

 

 

 1 



 

 

2. คลิกช่ือเว็บไซต 
3. คลิกปุม Edit 
4. คลิกแท็บ Advanced 
5. แกไขขอมูลตางๆ ตามตองการ 

เชน ช่ือเว็บไซต (Site name) และโฟลเดอร 
ที่เก็บไฟล (Local root folder) 

6. คลิก  
7. คลิก  

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.26 แสดงข้ันตอนการแกไขเว็บไซต 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

 

 

 
   2 

 

 
   3 

 

 
   7 

 

 
   4 

 

 

   5 

 

 
   6 

 

NOTE : 
   

คุณสามารถสรางเว็บไซตไดหลายๆ ไซต 
 ตามตองการแตจะทํางานไดครั้งละ 1 ไซตเทาน้ัน 
โดยเมื่อจะเปดใชเว็บไซตใดก็เลือกช่ือไซตน้ันจากเมนู 
บนพาเนล Files 
            คลิกเพื่อดูรายช่ือเว็บไซต 

             คลิกเลือกเว็บไซตที่ตองการเปด 

   ภาพประกอบที่ 1.27 แสดงข้ันตอนการเปดใชงานเว็บไซต 
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1. เลือก Modify > Page Properties 
2. คลิกเลือก Title/Encoding 
3. คลิกเลือกภาษา เชน ไทย (Windows) 
4. คลิก  

 

 

 

 

 

 

 

 
 
 

ภาพประกอบที่ 1.28 แสดงข้ันตอนการกําหนดภาษาของเว็บเพจ 
 

 

 

 

 

 

 

 
กอนที่จะเริ่มใสเน้ือหาลงในเว็บเพจ คุณควรกําหนดคุณสมบัติพื้นฐานของเว็บเพจกอน เพื่อจะไดใช

เปนคาเริ่มตนสําหรับการทํางานกับเว็บเพจน้ันตอไป เว็บเพจแตละหนาจะมีคุณสมบัติพื้นฐานเฉพาะตัวซึ่งไม
เกี่ยวของกับไฟลอื่น เชน ช่ือเว็บเพจ (title) , สีพื้น (background color) , ภาพฉากหลัง (background 
image) และสีของขอความประเภทตางๆ เปนตน การกําหนดคุณสมบัติเหลาน้ีทําไดโดยใชคําสั่ง Modify > 
Page Properties หรือกดคีย Ctrl + j หรือคลิกปุม  บนพาเนล Properties Inspector 

 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

การกําหนดภาษาของเว็บเพจ 

 

 

 

 

 
   1 

 

 
   2 

 

 
   3 

 

 
   4 

 

การกําหนดคุณสมบัติพ้ืนฐานของเว็บเพจ 
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NOTE :   คุณอาจจะใชวิธีคลิกปุม  บน Properties Inspector ก็ได 
  ถาปุมน้ีปรากฏอยู 
 
 
 
 

ภาพประกอบที่ 1.29 แสดงข้ันตอนการกําหนดภาษาของเว็บเพจ (ตอ) 
 

 



 

 

 
1. เลือก Modify > Page Properties 
2. หัวขอ Category เลือก Appearance 
3. หัวขอ Page font : ใหเลือก Microsoft Sans Serif (ซึ่งเปนฟอนตที่นิยมใชกัน) 

3.1 ถาไมมีฟอนตน้ีใหคลิกเลือก Edit Font List เพื่อโหลดฟอนตเพิ่มเขามา 
 
 
 

 

 

 

 

 

3.2 หัวขอ Available fonts: 
ใหเลือกฟอนต Microsoft Sans Serif 
แลวคลิก  ใหฟอนต Microsoft Sans Serif 
มาอยูทางชองซายหัวขอ Chosen fonts: 

3.3 คลิก  
เสร็จแลวมาเลือกตามขอที่ 3 
         3.4 คลิก  
   
     
 
 
 

 

 

 

     

  ภาพประกอบที่ 1.30 แสดงข้ันตอนการกําหนดชุดฟอนตตัวอักษร 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

 

 
   1 

 

 
   2 

 

 
   3 

 

 
   3.4 

 

 

 

 

 

 
   3.1 

 

 
   3.2 

 

 
   3.3 
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การกําหนดชุดฟอนตตัวอักษร 



 

 

- Page font  กําหนดชุดฟอนตตัวอักษรที่ตองการใชกับเว็บเพจทั้งหนา  
(Default Font หมายถึงไมระบุฟอนต) 

- Size  ขนาดของตัวอักษร (การกําหนดขนาดตัวอักษรตองระบุหนวย 
เสมอ)  

- Text color   สีของขอความทั่วไป (ไมรวมถึงขอความที่เปนไฮเปอรลิงค) 
- Background color สีพื้นหลังของเว็บเพจ 
- Background image ภาพฉากหลังของเว็บเพจ 
- Repeat  วิธีแสดงภาพฉากหลังแบบซ้ํา  ๆ
- Left margin ระยะขอบของเว็บเพจดานซาย 
- Right margin ระยะขอบของเว็บเพจดานขวา 
- Top margin ระยะขอบของเว็บเพจดานบน 
- Bottom margin ระยะขอบของเว็บเพจดานลาง 

 

 
 หัวเรื่องหรือไตเต้ิล (title) ของเว็บเพจมีความสําคัญมาก เพราะเปนขอความที่ใชแสดงบนไตเต้ิลบาร
ของบราวเซอร ซึ่งเปนสิ่งที่ผูชมเห็นเปนอยางแรกเมื่อเปดดูเว็บเพจน้ัน ขอความน้ีชวยอธิบายวาเว็บเพจน้ันมี
เน้ือหาเกี่ยวของกับอะไรได นอกจากน้ียังเปนขอมูลสําคัญที่ search enqine ใชคนหาเว็บเพจอีกดวย การใส
หัวเรื่องเว็บเพจทําไดหลายวิธี ดังน้ี 
วิธีที่ 1 

คลิกในชอง Title แลว 
พิมพขอความหัวเรื่องลงไป 

 

วิธีที่ 2 
1. คลิกปุม Page Properties 
2. คลิก Title/Encoding 
3. พิมพขอความหัวเรื่อง 
4. คลิก 

 

 

 

 

 
ภาพประกอบที่ 1.31 แสดงข้ันตอนการใสขอความหัวเรื่องเว็บเพจ 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 การใสขอความหัวเรื่องเว็บเพจ 

 
 

 

 

 

 

 

 

   1 

 

 

   2 

 

 

   3 

 

 

   4 
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การพิมพขอความในเว็บเพจจะคลายกับการพิมพเอกสารในโปรแกรม Word โดยเราสามารถ

จัดรูปแบบขอความใหสวยงามไดดวย โดยอาจใชตัวอักษรกราฟกที่สีตัวอักษรตัดกับสีพื้นฉากหลัง มีการ
เรียงลําดับยอหนา มีการจัดวางตําแหนงเน้ือหา ซึ่งจะชวยใหเว็บเพจเราดูนาสนใจย่ิงข้ึน 

 
 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.32 แสดงข้ันตอนการพิมพขอความลงบนเว็บเพจ 
เราสามารถจัดรูปแบบและขนาดตัวอักษรไดโดยใหเลือกขอความที่ตองการปรับแตงและแกไขคา

ตางๆ ไดที่ หนาตาง Properties Inspector โดยมีรายละเอียดตางๆ ดังน้ี 
 

รูปแบบยอหนาของ HTML สไตล CSS  ตัวเอียง 
ตัวหนา  จัดตําแหนงยอหนา 

 

 

 

   ชุดฟอนตตัวอักษร    ขนาดตัวอักษร  สีตัวอักษร    สราง List 
   หนวยของขนาดตัวอักษร  การเย้ืองยอหนา 

ภาพประกอบที่ 1.33 แสดงข้ันตอนการจัดรูปแบบขอความ 
 

 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 การพิมพขอความลงบนเว็บเพจ 
 

 

 
 

คลิกวางเคอรเซอรแลวพิมพขอความ 
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ในการใสขอความลงบนเว็บเพจ คุณอาจจะสังเกตวาเวลาเคาะเวนวรรคหลายครั้งติดๆ กันโปรแกรม

จะไมทําให โดยมันจะเวนวรรคเพียง 1 ครั้งเทาน้ัน วิธีทําใหเวนไดมากกวา 1 ตัวอักษรคือ 
กดคีย         +              +          ชองวางก็จะเพิ่มข้ึนตามจํานวนคลิก 
 

 
โดยปกติเมื่อเราพิมพขอความเต็มบรรทัด (หรือเต็มความกวางของขอบเขตตรงจุดน้ัน) โปรแกรมจะ

ปดขอความข้ึนบรรทัดใหมโดยอัตโนมัติ (การกดคีย Enter จะถือวาเปนการข้ึนยอหนาใหมซึ่งระยะบรรทัดจะ
หางกวาปกติ) แตถาคุณตองการปดขอความข้ึนบรรทัดใหมเอง ทําไดโดย 
กดคีย            +   
 

 
เราสามารถใสรูปภาพที่เตรียมไวแลวในเว็บเพจไดโดย 
1. วางตัวบอกตําแหนงการพิมพในตําแหนงที่จะใสรูปภาพ 
2. เลือกคําสั่ง  Insert > Image 
3. คลิกที่ชอง Look in เพื่อเปดไปยังไดรฟและโฟลเดอรที่เก็บไฟลภาพ 
4. เลือกไฟลรูปภาพที่ตองการ 
5. คลิก 

 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.34 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

การเวนวรรคระหวางขอความ 

Ctrl Shift Space Bar 

การขึ้นบรรทัดใหมในยอหนา 
 

Shift Enter 

การตกแตงเว็บเพจดวยรูปภาพ 
 

 

 

  

 

   1 

 

 
   2 

 

 
   3 

 
   4 

 

 

   5 

จัดทําโดย : นายธีรชัย  สายรัตน 

 

27 

 

 



 

 

6. เลือกกอปปไฟลภาพเขามาไวในเว็บไซต โดยคลิก Yes 
7. ดับเบิ้ลคลิกเพื่อเปดเขาไปยังโฟลเดอรยอยที่จะใชเก็บไฟลภาพ (หรือคลิกเลือกโฟลเดอร 

แลวคลิกปุม              ) 
8. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.35 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ 

รูปภาพจะปรากฏบนเว็บเพจ และไฟลที่กอปปเขามาเก็บในเว็บไซต ก็จะปรากฏช่ือในโฟลเดอรที่คุณ
กําหนดดวย 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.36 แสดงข้ันตอนการตกแตงเว็บเพจดวยรูปภาพ (ตอ) 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

 

 

 

 

รูปภาพที่ได
บนเว็บเพจ 

ไฟลรูปภาพ 

 

 
   6 

 

 

   7 

 

 
   8 
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วิธีตกแตงเว็บเพจใหสวยงามอยางหน่ึง ก็คือการนําภาพมาใสเปนพื้นหลังหรือแบ็คกราวนด 

(Background) ของเว็บเพจ เพื่อสรางความสะดุดตาและนาสนใจ 

 
1. เลือกคําสั่ง Modify > Page Properties… 
2. คลิกหัวขอ Appearance 
3. ในสวนของ  Background image  คลิกที่ปุม              เพื่อเลือกไฟลรูปภาพ 
4. เลือกไฟลรูปภาพที่ตองการนํามาทําพื้นหลังเว็บเพจ 
5. คลิกปุม  
6. คลิกปุม               จะปรากฏรูปภาพที่เราไดเลือกไวแสดงเปนพื้นฉากหลังของเว็บเพจ 

 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

ภาพประกอบที่ 1.37 แสดงข้ันตอนการใสภาพพื้นหลังเว็บเพจ 

 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

 

การแสดงภาพพ้ืนหลังเว็บเพจ 

ขั้นตอนการใสภาพพ้ืนหลัง 
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จัดทําโดย : นายธีรชัย  สายรัตน 
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การบันทึกเปนการจัดเก็บเว็บเพจหลังจากที่เราสรางข้ึนและมีการใสเน้ือหาลงไปแลว (หรือการ

จัดเก็บเว็บเพจเดิมที่ถูกเปดข้ึนมาแกไข) โดยปกติโปรแกรมจะกําหนดใหเว็บเพจมีนามสกุลเปน .htm หรือ 
.html แตหากตองการบันทึกเปนไฟลประเภทอื่นคุณก็สามารถเปลี่ยนแปลงได 

1. เลือก File > Save 
2. เลือกโฟลเดอรที่จะเก็บไฟล 
3. ต้ังช่ือไฟล 
4. (ถาตองการ) เลือกประเภทของไฟลที่จะบันทึก 
5. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.38 แสดงข้ันตอนการบันทึกหนาเว็บเพจ 
 

 
การทดสอบเว็บเพจดวยบราวเซอร สามารถทําไดโดยวิธีใดวิธีหน่ึง ดังน้ี 

วิธีที่ 1 
1. เลือกคําสั่ง File 
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การบันทึกหนาเว็บเพจ 
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การทดสอบเว็บเพจดวยบราวเซอร 

จัดทําโดย : นายธีรชัย  สายรัตน 
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2. เลือก Preview in Browser 
3. เลือกช่ือโปรแกรมบราวเซอร 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.39 แสดงข้ันตอนการทดสอบเว็บเพจดวยบราวเซอร 
วิธีที่ 2 

1. คลิกปุม  Preview/Debug in browser บนทูลบาร Document 
2. เลือกช่ือโปรแกรมบราวเซอร 

 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.40 แสดงข้ันตอนการทดสอบเว็บเพจดวยบราวเซอร (ตอ) 
วิธีที่ 3 
 กดคีย            บราวเซอรดีฟอลต (primary browser) จะถูกเรียกข้ึนมาแสดงเว็บเพจ 
ถาคุณยังไมไดบันทึกไฟลโปรแกรมอาจจะแจงเตือนออกมา ใหคลิก Yes เพื่อบันทึกไฟลกอนมิฉะน้ัน
บราวเซอรจะแสดงขอมูลเดิม 
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F12 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 การสรางหนาเว็บเพจใหม เพื่อออกแบบเว็บเพจ ตกแตงและนําไปใชงาน มีข้ันตอนดังน้ี 

1. เลือกคําสั่ง File > New จากเมนู 
2. ในแท็บ General ใหเลือกกลุมของเว็บเพจใหมที่จะสราง 
3. สําหรับการสรางเว็บเพจธรรมดาใหเลือก Basic page 
4. เลือกประเภทของเว็บเพจ เลือก HTML 
5. คลิกปุม  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.41 แสดงข้ันตอนการสรางเว็บเพจใหม 

 
การเปดเว็บเพจที่บันทึกไวมาเพื่อแกไข ตกแตงเพิ่มเติม มีข้ันตอนดังน้ี 
1. เลือกคําสั่ง File > Open 
2. เลือกโฟลเดอรที่เก็บเว็บไซตและโฟลเดอรยอยที่เก็บไฟล 
3. คลิกเลือกไฟลเว็บเพจ 
4. คลิกปุม  

 
คุณสามารถสรางหรือเปดเว็บเพจข้ึนมาทํางานไดพรอมกันหลายไฟล แตจะแกไขไดทีละไฟล 

โดยเมื่อตองการแกไขไฟลใดก็ใหคลิกเลือกที่แท็บช่ือของไฟลน้ัน หรือเลือกคําสั่ง Window > ชื่อไฟล 
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การสรางเว็บเพจใหม 

 

 
 

 

 
   1 

 

 
   2 

 

 
   3 

 

 
   4 

 

 
   5 

การเปดเว็บเพจ 
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ภาพประกอบที่ 1.42 แสดงข้ันตอนการเปดเว็บเพจ 
 

 
การออกจากโปรแกรม Macromedia Dreamweaver 8 ทําไดหลายวิธี ดังน้ี 

วิธีที่ 1 เลือกคําสั่ง File > Exit 
วิธีที่ 2 คลิกปุม  Close ตรงมุมบนดานขวา 
วิธีที่ 3 กดแปนพิมพปุม           +  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.43 แสดงข้ันตอนการออกจากโปรแกรม Macromedia Dreamweaver 8 
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การออกจากโปรแกรม Macromedia Dreamweaver 8 

Alt F4 

 

วิธีที่ 1   
วิธีที่ 2   

จัดทําโดย : นายธีรชัย  สายรัตน 
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1. ศึกษาวีดิทัศน โดยคลิกที่ “วีดิทัศน พื้นฐานการสรางเว็บเพจดวยโปรแกรม Macromedia  
Dreamweaver 8” 
 
 
 
 
 
 
 
 
 
 
    ภาพประกอบที่ 1.44 การเลือกวีดิทัศน 
 

2. การชมวีดิทัศนและการดาวนโหลดวีดิทัศน ใหปฏิบัติดังน้ี 

2.1 ถาตองการชมวีดิทัศน คลิกที่  

2.2 ถาตองการดาวนโหลดวีดิทัศน คลิกที่  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.45 การชมวีดิทัศนและการดาวนโหลดวีดิทัศน 
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 วีดิทัศน 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2.1 

 2.2 



 

 
 
 
 

1. คลิกเลือกใบงานที่ 1 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.46 การเลือกใบงานที่ 1 
 

2. อานคําช้ีแจงใบงานที่ 1 ใหเขาใจและคลิกที่ปุม  เพื่อเริ่มทําใบงานที่ 1 
 

 
 
 
 
 
 
 
    ภาพประกอบที่ 1.47 คําช้ีแจงใบงานที่ 1 
 

3. จะปรากฏหนาจอการยืนยันจากระบบ “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 
      3.1 ถายังไมตองการทําใบงานที่ 1 ใหคลิกปุม  

      3.2 ถาตองการทําใบงานที่ 1 ใหคลิกปุม  
 
 
 
 
 
 
 
    ภาพประกอบที่ 1.48 การยืนยันการทําใบงานที่ 1 
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ใบงานท่ี 1 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 

 3.1 
 3.2 



 

 
 
 4. ใบงานที่ 1 เปนแบบทดสอบแบงเปน 2 ประเภท 
     4.1 แบบทดสอบแบบจับคู ใหนักเรียนพิจารณาขอความดานซายมือที่กําหนดให และจับคูกับ
ขอความที่เปนตัวเลือกดานขวามือที่มีความสัมพันธกันมากที่สุด 
     4.2 แบบอัตนัย ใหนักเรียนพิจารณาขอความที่กําหนดใหและพิมพคําตอบที่ถูกตองลงในชองวาง 
     4.3 ทําแบบทดสอบเสร็จแลวใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 5. ระบบจะแจงสถานะของการทําใบงานที่ 1 ของแตละขอดังน้ี 
     5.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Incomplete answer” แสดงวาตอบ

ใบงานที่ 1 ไมครบ ใหคลิกปุม  
     5.2 ถาสถานะคําตอบทุกขอแสดงวา “Answer saved” แสดงวาตอบใบงานที่ 1 ครบทุกขอ ให
คลิกปุม  
 
 
 
 
   
 

ภาพประกอบที่ 1.50 ระบบแจงสถานะการทําใบงานที่ 1 
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 ภาพประกอบที่ 1.49 ใบงานที่ 1 

 4.1 

 4.2 

 4.3 

 5.1 

 5.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 6. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 

     6.1 ถาตองการกลับไปแกไขคําตอบ ใหคลิกปุม  

     6.2 ถาตองการสงคําตอบ ใหคลิกปุม  
 
 
 
 
 
 
 

ภาพประกอบที่ 1.51 ระบบแจงการยืนยันการสงใบงานที่ 1 

 7. เมื่อคลิก  ระบบจะเฉลยขอสอบวาถูกหรือผิดใหเลื่อนดูจนครบ

ทุกขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่  
 
 
 
 
 
 
 
 
 
 

 
8. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
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 6.1 

 6.2 

 ภาพประกอบที่ 1.52 ระบบเฉลยใบงานที่ 1 

 
ภาพประกอบที่ 1.53 ระบบแสดงคะแนนใบงานที่ 1 

จัดทําโดย : นายธีรชัย  สายรัตน 

 7 

 8 



 

 
 
 
 

1. คลิกเลือกแบบฝกปฏิบัติที่ 1 
 
 
 
 
 

 

ภาพประกอบที่ 1.54  การเลือกแบบฝกปฏิบัติที่ 1 
 

2. แบบฝกปฏิบัติที่ 1 ใหนักเรียนศึกษาคําช้ีแจงใหเขาใจและปฏิบัติงาน เมื่อปฏิบัติงานเสร็จ 
เรียบรอย ใหสงงานตามข้ันตอนตอไปน้ี 

2.1 ใหคลิกปุม  
2.2 คลิกปุม Add…( ) 
2.3 คลิกที่ Upload a file คลิกปุม  และเลือกไฟลที่ตองการ 
2.4 คลิกปุม  
2.5 คลิกปุม  เปนการเสร็จสิ้นการสงไฟลงาน 
2.6 เมื่อครูผูสอนตรวจงานเสร็จแลว นักเรียนสามารถดูคะแนนไดที่ “สถานะคะแนน” 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพประกอบที่ 1.55  ข้ันตอนการสงไฟลงาน 
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แบบฝกปฏิบัติท่ี 1 

 

 1 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
   ภาพประกอบที่ 1.56  ข้ันตอนการสงไฟลงาน (ตอ) 
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 2.1 

 

 

 

 2.2 

2.3 

 2.4 

 2.5 

 2.6 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 

1. คลิกเลือกแบบฝกหัดที่ 1 
 
 
 
 
 
 

    ภาพประกอบที่ 1.57  การเลือกแบบฝกหัดที่ 1 
 

2. อานคําช้ีแจงแบบฝกหัดที่ 1 ใหเขาใจและคลิกปุม  เพื่อเริ่มทําแบบฝกหัดที่ 1 
 

 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.58  คําช้ีแจงแบบฝกหัดที่ 1 
 

3. จะปรากฏหนาจอการยืนยันจากระบบวา “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถทําได 1  
ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” 

3.1 ถายังไมตองการทําแบบฝกหัดที่ 1 ใหคลิกปุม  
3.2 ถาตองการทําแบบฝกหัดที่ 1 ใหคลิกปุม  
 
 
 
 
 
 
  

ภาพประกอบที่ 1.59  การยืนยันการทําแบบฝกหัดที่ 1 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

40 

แบบฝกหัดท่ี 1 

 

 1 

 

 

 2 

 3.1 

 3.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 4. ทําแบบฝกหัดที่ 1 โดยปฏิบัติดังน้ี 
     4.1 ใหนักเรียนพิจารณาขอความที่กําหนดใหวาถูกหรือผิด ถาขอความน้ันถูกตองเลือก True ถา
ขอความน้ันไมถูกตองเลือก False 

     4.2 เมื่อทําแบบฝกหัดที่ 1 เสร็จแลวใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.60  แบบฝกหัดที่ 1  
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จัดทําโดย : นายธีรชัย  สายรัตน 

 4.1 



 

 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.61  แบบฝกหัดที่ 1 (ตอ) 
 
 5. ระบบจะแจงสถานะของการทําแบบฝกหัดที่ 1 ดังน้ี 
     5.1 ถาสถานะคําตอบแสดงคําวา “Not yet answered” แสดงวาแบบฝกหัดที่ 1 ตอบไมครบ 

ใหคลิกปุม  
     5.2 ถาสถานะคําตอบแสดงคําวา “Answer saved” แสดงวาตอบแบบฝกหัดที่ 1 ครบทุกขอ ให

คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.62  ระบบแจงสถานะการทําแบบฝกหัดที่ 1  
 

6. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 
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 4.2 

 5.1 

 5.2 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
     6.1 ถาตองการกลับไปแกไขคําตอบ ใหคลิกปุม  
     6.2 ถาตองการสงคําตอบ ใหคลิกปุม  
  
      
 
 
 
 
 
 
 

ภาพประกอบที่ 1.63  ระบบแจงการยืนยันการสงแบบฝกหัดที่ 1  
 

 7. เมื่อคลิก  ระบบจะแสดงผลดังน้ี 
     7.1 ระบบเฉลยแบบฝกหัดที่ 1 วาถูกหรือผิด ใหคลิกเลื่อนดูจนครบทุกขอ 
     7.2 เมื่อดูเฉลยเสร็จแลวใหคลิกที่ Finish review 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.64  ระบบเฉลยแบบฝกหัดที่ 1  
 
 8. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.65  ระบบแสดงคะแนนแบบฝกหัดที่ 1   
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จัดทําโดย : นายธีรชัย  สายรัตน 

 6.1 

 6.2 

 7.1 

 7.2 

 8 



 

 
 
 
 

1. คลิกเลือกแบบทดสอบหลังเรียนที่ 1 
 

 
 
 
 
 
 

ภาพประกอบที่ 1.66  การเลือกแบบทดสอบหลังเรียนที่ 1   
 

2. ทําแบบทดสอบหลังเรียนที่ 1 โดยอานคําช้ีแจงใหเขาใจ 
คําช้ีแจง แบบทดสอบหลังเรียนที่ 1 เปนแบบทดสอบแบบปรนัย 4 ตัวเลือก จํานวน 10 ขอ  

ใหคลิกเลือกคําตอบที่ถูกที่สุดเพียงคําตอบเดียว คะแนนเต็ม 10 คะแนน แบบทดสอบน้ีจับเวลาในการทํา
แบบทดสอบ 10 นาท ี

3. คลิกปุม  
 
 
 
 
 
 

ภาพประกอบที่ 1.67  คําช้ีแจงแบบทดสอบหลังเรียนที่ 1   
 

4. จะปรากฏหนาจอการยืนยันจากโปรแกรม “แบบทดสอบน้ีมีการจํากัดเวลาและสามารถ ทําได  
1 ครั้ง ทานกําลังจะเริ่มการทําแบบทดสอบครั้งใหม จะดําเนินการตอหรือไม” ใหปฏิบัติดังน้ี 

4.1 ถายังไมตองการทําแบบทดสอบหลังเรียนที่ 1 ใหคลิกปุม  

4.2 ถาตองการทําแบบทดสอบหลังเรียนที่ 1 ใหคลิกปุม  
 

 
 
 
 
 

ภาพประกอบที่ 1.68  การยืนยันการทําแบบทดสอบหลังเรียนที่ 1   
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 แบบทดสอบหลังเรียนท่ี 1 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 

 3 

 4.1  4.2 



 

 
 
 5. ทําแบบทดสอบหลังเรียนที่ 1 จํานวน 10 ขอ โดยคลิกที่วงกลมหนาตัวเลือก a, b, c, หรือ d ที่
ตองการ โดยขอสอบจะมีการสลับขอและสลับตัวเลือกทุกครั้งเมื่อมีการทําแบบทดสอบ 
 6. เมื่อทําแบบทดสอบหลังเรียนที่ 1 เสร็จแลว คลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.69  แบบทดสอบหลังเรียนที่ 1   
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จัดทําโดย : นายธีรชัย  สายรัตน 

 5 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.70  แบบทดสอบหลังเรียนที่ 1  (ตอ) 
  

7. ระบบจะแจงสถานะของการทําแบบทดสอบหลังเรียนที่ 1 ใหปฏิบัติดังน้ี 
    7.1 ถาสถานะคําตอบแตละขอมีขอใดขอหน่ึงแสดงคําวา “Not yet answered” แสดงวาตอบ

แบบทดสอบหลังเรียนที่ 1 ไมครบ ใหคลิกปุม  
    7.2 ถาสถานะคําตอบทุกขอแสดงคําวา “Answer saved” แสดงวาตอบแบบทดสอบหลังเรียน

ที่ 1 ครบทุกขอ ใหคลิกปุม  
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.71  ระบบแจงสถานะการทําแบบทดสอบหลังเรียนที่ 1    
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จัดทําโดย : นายธีรชัย  สายรัตน 

 6 

 7.1 

 7.2 



 

 
  
 8. ระบบจะแจงการยืนยัน “คุณกําลังจะออกจากการทําแบบทดสอบ หากออกจากการทํา
แบบทดสอบแลวคุณจะไมสามารถเปลี่ยนแปลงคําตอบได” ใหปฏิบัติดังน้ี 
     8.1 ถาตองการกลับไปแกไขคําตอบใหคลิกปุม  

     8.2 ถาตองการสงคําตอบใหคลิกปุม  
 
 
 
 
 
 
 

ภาพประกอบที่ 1.72  ระบบแจงการยืนยันการสงคําตอบ 
 

 9. เมื่อคลิก  ระบบจะเฉลยแบบทดสอบหลังเรียนที่ 1 วาถูกหรือผิด 
ใหเลื่อนดู ใหเลื่อนดูจนครบทั้ง 10 ขอ เมื่อดูเฉลยเสร็จแลวใหคลิกที่ “Finish review” 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.73  ระบบเฉลยแบบทดสอบหลังเรียนที่ 1 
 
 10. ระบบจะแจงคะแนนที่ได ใหคลิกปุม  เพื่อกลับสูบทเรียนตอไป 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.74  ระบบแสดงคะแนนแบบทดสอบหลังเรียนที่ 1 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

 

47 

 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 8.1 

 8.2 

 9 

 10 



 

 
 
 
 

1. การออกจากบทเรียน ใหคลิกที่ “หนาหลัก” 
2. คลิก “(ออกจากระบบ)” 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพประกอบที่ 1.75 การออกจากบทเรียน 
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การออกจากบทเรียน 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

 1 

 2 
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 บรรณานุกรม 

จัดทําโดย : นายธีรชัย  สายรัตน 
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ภาคผนวก 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

ขอ คําตอบ 

1 a 

2 a 

3 d 

4 b 

5 a 

6 c 

7 c 

8 a 

9 b 

10 a 

 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 

 

51 

 เฉลยแบบทดสอบกอนเรียนท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 
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เฉลยใบงานท่ี 1 

 

 

คําตอบ คําถาม 

คําตอบ 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 เฉลยแบบฝกปฏิบัติท่ี 1 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

( ข้ึนอยูกับการออกแบบของนักเรียน ) 
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เฉลยแบบฝกปฏิบัติท่ี 1 (ตอ) 

 

จัดทําโดย : นายธีรชัย  สายรัตน 
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 เฉลยแบบฝกหัดท่ี 1 

 

 

จัดทําโดย : นายธีรชัย  สายรัตน 

คําตอบ 

คําถาม 
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 เฉลยแบบฝกหัดท่ี 1 (ตอ) 

 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 

ขอ คําตอบ 

1 b 

2 c 

3 d 

4 c 

5 c 

6 b 

7 d 

8 d 

9 a 

10 d 
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เฉลยแบบทดสอบหลังเรียนท่ี 1 

จัดทําโดย : นายธีรชัย  สายรัตน 



 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 ชื่อ   นายธีรชัย  สายรัตน 
 วัน เดือน ป เกิด  4 ธันวาคม 2515 
 ท่ีอยูปจจุบัน  1 หมูที่ 7 ตําบลสําโรง อําเภอเมือง จังหวัดสุรินทร 
 ประวัติการศึกษา ศึกษาศาสตรมหาบัณฑิต (ศษ.ม.) สาขาวิชาการบริหารการศึกษา 
    จากมหาวิทยาลัยรามคําแหง 
    ครุศาสตรบัณฑิต (ค.บ.) วิชาเอกคอมพิวเตอรศึกษา  

จากสถาบันราชภัฏจันทรเกษม 
 รับราชการ  เริ่มรับราชการเมื่อ 2 พฤศจิกายน 2552 ตําแหนงครูผูชวย โรงเรียนครบุร ี
    จังหวัดนครราชสีมา สังกัดองคการบริหารสวนจังหวัดนครราชสีมา 
    ปจจุบัน ตําแหนง ครู วิทยฐานะ ครูชํานาญการ โรงเรียนครบุร ี
    จังหวัดนครราชสีมา สังกัดองคการบริหารสวนจังหวัดนครราชสีมา 
 

 
หนวยท่ี 3 การออกแบบเว็บไซตดวยโปรแกรม Macromedia Dreamweaver 8 
ชุดที่ 1 พ้ืนฐานการสรางเว็บเพจดวยโปรแกรม Macromedia Dreamweaver 8 
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ประวัติผูจัดทํา 

 

จัดทําโดย : นายธีรชัย  สายรัตน 


